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Este documento provee información para instalar las 
soluciones eScan y sirve como una referencia rápida 

para ejecutar tareas claves. 
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Instalación de eScan  
 
Esta sección brinda información sobre los requerimientos necesarios de 
software y hardware para poder instalar el producto eScan y facilita con 
instrucciones paso por paso su instalación. 
  

 
Requisitos necesarios de Software y Hardware  
 
Su computador debe tener sistema operativo Windows XP/Windows Vista, 
contar como mínimo con 512 MB RAM y 50 MB libres de espacio en disco duro 
así como conexión a internet.  
 
 

Prerequisitos para Instalación  
 
Antes de instalar el software, debe asegurarse de hacer lo siguiente:  
 
• Revisar que su sistema operativo sea Windows XP o Windows Vista.  
 
• Su computador debe tener como mínimo 512 MB RAM y 50 MB libres de 
espacio en disco duro así como conexión a internet.  
 

• Desinstale cualquier software de Anti Virus incluyendo versiones 
previas de estos productos.  
 
• Revise que instale el producto eScan en la partición con más espacio 
en el disco.  
 
• Necesita derechos de Administrador en la PC.  
 
• Se enviarán mensajes de advertencia a la dirección IP del servidor de 
correo. Si la autenticación para el servidor de correo es requerida para 
aceptar correo, entonces se debe contar con un usuario y password para 
enviar correo.  
 



 
 
 
Proceso de Instalación 
 
Esta sección le da una guía de instalación del producto paso por paso.  
 
• Ejecutar el programa descargado por internet, y le aparecerá la siguiente 

pantalla 
 

 
 

 
• Luego, deberá aceptar las condiciones de la Licencia, haciendo doble clic 

sobre el cuadro “Yes” 
 

 
 
 
 
 



• Una vez aceptadas las condiciones de la Licencia, le aparece la pantalla del 
directorio de instalación.  Puede hacer clic en la palabra “Next” o cambiar el 
destino donde descargará el producto haciendo clic en “Browse”.  Le 
aparece la siguiente pantalla: 

 

 
 

• Una vez seleccionado el lugar donde será instalado el producto, está listo 
para comenzar la instalación con la siguiente pantalla donde hará clic en 
“Install” 

 

 
 

• Posteriormente comenzarán a aparecer una serie de pantallas que irán 
mostrando el avance de extracción de los archivos requeridos.  

 

 
 



• Se instalarán también los últimos parches correspondientes a las últimas 
actualizaciones. 

 

 
 

 

• Posteriormente se corre el Kit de la Herramienta Micro World Antivirus que 
hace una revisión completa de los archivos y el sistema con el fin de buscar  
virus escondidos. 

 

 
 

• Una vez finalizado el proceso anterior, le aparecerá una nueva pantalla 
donde usted debe ingresar el código de su licencia original  

 

 



• Para proceder con la finalización de la instalación, deberá hacer un reboot a 
su máquina haciendo clic en la palabra “yes” para reiniciar el sistema y 
posteriormente debe seleccionar “Finish”. 

 
Después de la instalación, usted observará los siguientes íconos adjuntados a 
su bandeja del sistema, al final de la Pantalla en la esquina derecha. Estos son 
diferentes módulos que ejecutan diferentes menús con el fin de ayudarle a 
ejecutar tareas específicas.  
 

• Haga Doble clic  para ejecutar el Monitoreo de Antivirus eScan. Usted 
puede seleccionar los archivos y carpetas a escanear, especificar acciones para 
correr cuarentenas o borrar archivos en caso de ser detectados como 
infectados con virus.  
 

• Hacer clic derecho sobre   para abrir un popup que facilita correr 
módulos de eScan como “On Demand Scanner” que permite escanear su 
computador en cualquier momento; “Content Administrador” para 
establecer políticas de seguridad para su red; “eScan Updater” para 
configurar ciertas acciones y hacer actualizaciones mediante descargas 
automáticas que protejan su sistema de los últimos virus. También puede 
ejecutar el “eScan Anti Virus Monitor”. Los módulos están completamente 
integrados con un sistema de Ayuda disponible en línea en la barra de 
herramientas que puede ser accedido en HELP / eScan Content Administrator 
Help.  
 
eScan tiene un completo y poderoso sistema de Ayuda en línea que provee 
información detallada sobre cada pantalla y campo.  Para obtener información 
sobre un campo, botón o caja de diálogo que aparezca en la Pantalla, haga clic 
sobre el objeto y presione F1. 
 
 
Usando “On Demand Scanner” 
 
Escaneo de un Diskette  
 
• Inserte un diskette dentro de la unidad de diskette.  
 

• Con el botón derecho haga clic en  y seleccione “Scan Floppy”  
 
Escaneo de Archivos y Directorios  
 

• Haga clic con el botón derecho sobre  y seleccione “Start eScan for 
Windows”.  
 



• El modulo “On Demand Scanner” comenzará a correr. En el borde izquierdo 
de la Pantalla, seleccione “Actions > Check Computer”. Luego haga clic en 
“Start”.  
 
• El programa comenzará a correr y usted debe seleccionar qué archivos o 
carpetas debe escanear.  
 
Escaneo de un CD – DVD  
 

• Con el botón derecho haga clic sobre  y seleccione “Start eScan for 
Windows”.  
 
• El módulo “On Demand Scanner” comienza a correr.  En el borde izquierdo 
de la Pantalla, seleccione “Actions > Check CD ROM”. Luego seleccione “ 
Start”.  
 
• El programa empezará a ejecutarse y el CD/DVD es escaneado.  
 
 
Ajuste diferentes opciones de escaneo de Virus  
 

• Haga clic sobre  y seleccione “Start eScan for Windows”.  El modulo “On 
Demand Scanner” empezará a ejecutarse. Nuevamente haga clic en “Options”.  
 
• Saldrá una página con  2 lengüetas: “Virus Check” o revisión de virus y 
“Status”.  
 
• La opción “Virus Check” le permite seleccionar el tipo de escaneo así como 
detectar que tipo de infección en caso de tener alguna.  
 
• La opción “Status” le permite generar alertas cuando sus actualizaciones ya 
son obsoletas y require nuevas para mantener su sistema protegido.  
 
 

Ajuste de Descarga de Actualizaciones automáticas 
 
 

• Haga clic  y seleccione “Start eScan for Windows”. El módulo “On 
Demand Scanner” comenzará a ejecutarse. Haga Clic en “Scheduler > Add new 
task”.  
 
• Se mostrará una Pantalla con una caja de diálogo de revisión automática de 
virus.  
 
• En cada una de las diferentes opciones deberá ingresar valores apropiados 
para proceder a ejecutar las descargas automáticas de manera correcta.  



 
 
Uso de “eScan Updater”  
 
Seleccione “Update Download Mode”.  
 

• Presione clic derecho  y seleccione “eScan Updater Options”. El módulo 
de actualización comenzará a ejecutarse y se desplegará una pantalla con 4 
lengüetas.  
 
• Lengüeta “In General”/Select Mode, selecciona el modo de descarga. Las 
otras lengüetas serán habilitadas y ahora podrá configurar todas las demás 
opciones a sus necesidades. 
 
Ajuste para descargas automáticas  
 
• En la lengüeta “eScan Updater/General Config, haga clic en “Scheduling”.  
 
• Se desplegará la Pantalla de “Advanced Settings”. Escoja la opción de 
descarga automática y especifique el intervalo en minutos entre una descarga 
y otra.  Usted puede seleccionar la hora de cada descarga o eventualmente los 
días de descargas. 
 
Uso de “Content Administrator”  
 

• De un clic derecho sobre  y seleccione “Start eScan Content 
Administrador”.  El módulo comenzará a ejecutarse y en el lado izquierdo 
de la pantalla se despliegan varios menus que permiten realizar las 
siguientes tareas.  

 
Control de Anexos de Email (E-mail Attachment Control)  
 
Bloqueo de Anexos  
 

• Haga Clic sobre  En la opción “Block Attachment type”, digite la 
extension de los archivos que desee bloquear, como por ejemplo *.exe.  
 

• Luego haga Clic sobre  . El nombre del anexo se desplegará en la 
lista.  
  
Compresión de anexos recibidos (Zip Outbound Attachment)  
 

• Haga Clic sobre . En la opción “Configure Compression/Decompression”, 
seleccione la opción “Compress outbound Attachment checkbox”.  



 
 
Borrado de Anexos Dudosos o Contenido Peligroso   
 

• Haga Clic en . Al desplegar la pantalla, haga clic en .  
 
• Se desplegará una caja de diálogo con 3 lengüetas.  
 
• Abra la lengüeta “IE Vulnerabilities I” y seleccione “Delete Files with CLSID 
Extension” y borre  “HTML with Scripts”. 
 
 
Borrado de archivos con extensiones múltiples  
 

• Haga Clic sobre . Al desplegar la Pantalla, haga clic nuevamente sobre 

.  
 
• Abra la lengüeta “IE Vulnerabilities II” y seleccione “Delete Mail”.  
 
 
Archivo de correo y anexos (Archive Mails & Attachments)  
 

• Haga Clic sobre . Al desplegar la Pantalla, haga click en .  
 
• Abra la lengüeta “Archival”.  Seleccione “Archive eMails and Archive 

Attachment”.  
 
 
Detección de Spam en correos  
 

• Haga Click sobre  y seleccione “Enable Content Checking checkbox”.  
 
 
Bloqueo por restricción de palabras  
 

• Haga Clic sobre , en la opción “Phrase To Check”, digite la frase a 
bloquear en el campo requerido.  
 

• Haga Clic en  y la frase a bloquear se desplegará en la lista.  
 
 
Crear una Excepción de Responsabilidad 
 



• Haga Clic en . En la opción “Disclaimer”, seleccione la opción “Add 
Disclaimer to outbound Mails”.  
 
• Haga Clic en la última caja y digite el texto y luego en el botón presione el 
botón “Save”.  
 
 
Escaneo de páginas Web  
 
Habilitación de Escaneo de Páginas Web  
 

• Haga Clic en  y seleccione el botón “Active”.  
 
Bloqueo de acceso a internet por período definido  
 

• Haga Clic en  y seleccione  .  
 
• Se despliega la caja de programación y se selecciona la opción “Enable Time 
Restriction”.  
 
• Hacer Clic en Add.  Se despliega la caja “The Addition/ Modification of 
Scheduling”.   Seleccione “Enable this Schedule”.  
 
• Haga selecciones adecuadas en los campos mostrados. 
 
 
Bloqueo de Pornografía  
 

• Haga Clic en  y seleccione . Se despliega la opción 
“Advanced”.  
 
• En la opción “Content Matching Options”, seleccione la opción correcta.  
 
 
Bloqueo de Imagenes, Mensajes (RFC 822) y Aplicaciones  
 

• Haga Clic en  y seleccione . Se despliega la opción 
“Advanced”.  
 
• En la opción “Content Type”, seleccione las marcas correctas. 
 
 
Configuración de Umbral de contenido según la evaluación de los sitios 
visitados.  



 

• Haga Clic en  y seleccione . Se despliega la opción 
“Advanced”.  
 
• En la opción “Set Rating”, seleccione las marcas correctas.  
 

• Haga Clic en . Usted puede seleccionar estándares de rating 
seleccionados por los tres estándares internacionales.  
 
 
Uso del Filtro de PopUps   
 
Habilitación del Filtro de Pop-Ups  
 

• Haga Clic en  y seleccione la opción “Block Popup”.  
 
 
Agregue sitios para permitir PopUps  
 

• Haga Clic en . Seleccione la opción lista blanca “White List”, y luego el 
botón “Add”. Posteriormente se mostrará la caja de la Lista Blanca. 
 
 
• Para permitirlos los pop us, digite el URL de los sitios permitidos y haga clic 

en el botón “OK”.  
 
Permiso temporal para PopUps 
 

• Haga Clic en  y seleccione  . Aparecerá la caja de “Hot Key”.  
 
• Seleccione las teclas rápidas deseadas del campo.   Al mantener presionada 
esta tecla se permiten los popups. 
 
 
Uso de Limpieza por Browser  
 
Ejecución de la opción “Auto Erase/Privacy Protector”. 
 

• Haga Clic en  y seleccione la lengüeta General.  Seleccione la opción 
“Run at System Startup” o “Run Everyday”.  
 
• En la opción “Windows Auto Erase Options”, seleccione las marcas 
correspondientes.  



 
• Para correr la opción de Limpieza del Browser inmediatamente, presione el 
botón “Run Checked”. Todas Las ligas en las áreas seleccionadas del paso 
anterior serán borradas. 
 
Asignación de Derechos para acceso remoto de archivos (Assign 
Remote Access File Rights)  
 
Habilitación Remota del Acceso de los Derechos del Archivo  
 

• Haga Clic en  y seleccione la opción de “Enable Remote Access File 

Rights”.  
 
Configuración de los derechos de Modificación de Archivo   
 

• Haga Clic en . Aparecerán 4 opciones en la Pantalla que permiten o 
prohiben al usuario modificar ciertos tipos de archivos específicos.  
 
•Digite el tipo de extension del archivo, por ejemplo *.exe en la parte de arriba 
del campo y luego haga clic en “Add”.  
 
 
Permiso Notificaciones a Usuarios 
 
Habilitar envío de Alertas  
 

• Haga clic sobre  y seleccione “Show Alerts Dialog”  
 
• En la parte de abajo, seleccione las opciones necesarias para diferentes 
alertas. Las alertas seleccionadas serán enviadas al ser requeridas según sus 
indicaciones. 
 
Borrado de mensajes del usuario 
 

• Haga Clic sobre  . En la opción “Delete Mails From User”, digite su 
dirección de correo. (e-mail ID). 
 
• Haga Clic sobre “Add”. La identificación del usuario se mostrará en la cajita y 
todos los correos de este usuario serán borrados de forma automática. 
 
 

Selección de Notificación de Mensajes  
 



• Haga Clic sobre . En la ventana “Show Alert”, seleccione el tipo de 
alerta que sera notificada mediante un correo.  
 
• El mensaje asociado se mostrará en la parte de abajo de la caja.  De ser 
requerido, puede hacer las modificaciones necesarias. 
 
 
Cómo digitar el Código de la Licencia 
 

• Haga Clic en  y digite el código de la licencia en Pantalla mostrada.  
 
Vistas  
 
Ver Registro de Actividad  
 
• En la barra de herramientas, seleccione “View > View Log File”. 
 
Ayuda  
 
Cambio de Password  
 
• En la barra de herramientas, seleccione “Help > Change Password”  
  
 
Uso del Monitor de Anti-virus eScan (AVM) 
 

Haga click  sobre  y seleccione “Monitor Settings > Enable eScan Monitor”. 
Por omisión se habilitará el eScan AVM y luego aparecerá un liga a popups bajo 
la etiqueta “Disable eScan Monitor”.   Si usted hace clic sobre la liga, el eScan 
AVM se deshabilitará. 
 
Cambio de configuración del Monitor de eScan  
 

• Haga clic sobre  y seleccione “Monitor Settings > eScan Monitor”.  
 
 
Seleccione objetos para escanear  
 

• En eScan AVM, haga clic en  . Se desplegará el árbol del sistema de 
directorio en el lado derecho.  
 
• Para seleccionar el objeto a escanear, seleccione la caja adyacente y cliquee 

 y para que el símbolo  aparezca.  



 
 
Configure las opciones de escaneo 
 

• En eScan AVM, haga clic sobre . Aparecerán algunas opciones para 
escaneo al lado derecho.  
 
• Para seleccionar la opción, seleccione la caja adyacente y haga clic en  para 
que el símbolo  aparezca.  
 

• Haga Clic sobre  para buscar su sistema para seleccionar un archivo o 
carpeta.  
 

• Cliquee nuevamente  para usar el botón “spin” y cambia los valores 
previamente configurados para la opción.  
 
 
Personalizar eScan AVM  
 

• En eScan AVM, haga clic en  . Se desplegarán en la Pantalla las opciones 
de personalización en el lado derecho.  
 
• Para seleccionar la opción, seleccione nuevamente la caja adyacente y haga 
click en  para que aparezca el símbolo  .  
 

• Haga click en  para buscar en su sistema un archive o carpeta.  
 

• Cliquee  para usar el botón “spin” y cambiar los valores previamente 
configurados para la opción.  
 
 
Obtenga detalles para escaneo  
 

• En eScan AVM, haga clic sobre . Se mostrarán los detalles de escaneo 
en el lado derecho.  
 
 
Descargue el Monitor eScan AV   
 
• En la barra de herramientas del eScan AV Monitor, seleccione “File > Unload 
eScan Monitor”.  
 



 
Ver opciones del Monitor de eScan AV  
 
• En la barra de herramientas del eScan AV Monitor, seleccione “Monitor > 
View Monitoring Options”  
 
 
 
 
 


